Figure 1 Representative geolocator tracks from four grey-headed albatrosses during the nonbreeding period.
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Summary
This manual is divided into three sections in addition to the introduction. The first
discusses how to use BAS archival geolocators. The second describes post processing
techniques using BAS software. The third section briefly discusses interpretation of
data. This area of technology and science is not mature and currently evolving. We
welcome feedback and suggestions for improvement to both hardware and software.
Currently, loggers are only available to collaborators, subject to a Letter of
Understanding (LOU). Sampling and recording intervals are set at manufacture and
cannot be altered by the user. For further information, contact James Fox
(j.fox@bas.ac.uk) in the Antarctic and Marine Engineering group at the British
Antarctic Survey.

Introduction
Geolocation summary
Light level geolocation is the calculation of position from ambient light level readings
with reference to time, and is a highly effective technique for tracking long distance
migratory species. After data download, decompressed data is processed by software
to estimate position: latitude from day/night length, and longitude from the absolute
time of local midday/midnight. The accuracy of this technique is affected by a number
of factors including season, latitude, cloud cover, interference from artificial light
sources, shading, changes in sensor orientation, distance travelled etc. For these
reasons an average error ± SD of no better than 185 ± 115 km should be expected for
a flying seabird. In addition, for 2-3 weeks around each equinox, when day length is
approximately equal everywhere, the calculation of latitude is unreliable or
impossible (longitude is unaffected by equinox).
The logger (geolocator) is a battery powered instrument with an in-built
microprocessor and a memory for data storage. It is encapsulated in a clear, water
resistant package, with two external terminals for command and data transfers. The
recorder can be reused for the life of the battery (non replaceable). It may be put into a
recording mode for collecting and delivering data, or into a sleep mode to save battery
power for longer shelf life (note that sleeping only reduces battery consumption by
about 20%). When in recording mode it may be attached onto the bird.
The logging engine takes a light level reading at certain intervals (for our loggers
usually every minute) and, from those, then saves to memory the maximum light
measurement every recording interval (for our loggers this can be 10, 5 or 2 minutes).
Currently, light measurement is 6-bit and the range is limited to dim light levels.

Activity summary
A number of our loggers also record wet/dry information. This is achieved by
measuring conductivity; hence the 'wet' state will only be recorded if the water is
salty. Most of our devices sample for wet/dry every 3 seconds and make a record of
the total number of samples wet every 10 minutes. Given the sampling interval of 3
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seconds, the value recorded at the end of each 10 minute period ranges from zero
(always dry) to 200 (always wet).
Note that the Mk7 and Mk19 have a different activity recording strategy to this and
give higher time resolution; the penalty is that the memory fills quicker than with the
normal algorithm. These devices record the exact time (within 3secs) a state change
occurs; but the new state is recorded only if it is sensed for 6secs or more.

Temperature summary
Some of our larger loggers equipped with wet/dry recording also record temperature
to allow satellite sensed sea surface temperature (SST) correlation to aid geolocation.
For the Mk5 and Mk15: temperature is recorded after 20mins continuous wet,
temperature is recorded again after 40mins continuous wet. This may repeat every 4
hours of continuous wet. Temperature wet timer will reset anytime device goes dry
for >3secs.
For the Mk7 and Mk19: temperature is recorded after 20mins continuous wet, repeats
every 24.8 hours. Temperature wet timer will reset anytime device goes dry for
>6secs.
However, the temperature wet timer is also reset if a 2-day (48hr) marker is saved
during a continuous wet period. This will simply result in (an) additional temperature
reading(s).
The number of records per day will therefore be related to the number of sessions
spent on the sea surface. Most albatrosses, for example, rest on the water for several
hours each night, and therefore temperature records will usually be more frequent
during darkness. Temperature data is written within the activity data area. The data
has a resolution of 0.125’C, and an accuracy of ±0.5° at temperatures above 0°C, and
±1°C below 0° (can be improved through calibration).
The easiest way to do a temperature calibration (highly recommended) is probably to
do something along these lines: set the devices logging, put them in the salt water
temperature bath for 45mins, change the temperature to the next increment, lift them
out for a little while, put them back in for 45mins and so on. Note that for accurate
calibration, a proper temperature calibration bath should be used or, at least, a large
vessel of moving water with insulated sides and top (e.g. floating polystyrene). Place
the temperature probe close to the loggers and the heater far away. Also remember
that a temperature calibration can only be as good as the accuracy of the temperature
probe.

Availability
For up to date availability, see www.birdtracker.co.uk. At the time of writing:
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Software on BASTrak CD
There are a number of files supplied on this CD. See the readme.txt file and the data
processing section in this manual for installing the BASTrak, TransEdit and
BirdTracker software.
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Performing geolocation studies using BAS light level
geolocators
Is your target species compatible with the method?
The answer may not be clear and you may need to perform a trial. You should
establish that the geolocator is suitable for both giving you the data you want and also
that it will not unduly affect the animal. Observing how a captive animal reacts to a
dummy attachment should be one step.
The geolocator is purely archival; you must physically handle the animal to attach it.
You must then find the animal again at the end of the deployment and recover the
instrument in order to get the data. However, the modest cost of the instrument may
make even a poor recapture rate suitable for study.
Our loggers are for threshold geolocation analysis. They are largely unsuitable for
curve fitting methods because the range of light level they record is very limited.
An accuracy in the region of +/-100miles can be obtained from practical studies.
Unless the animal you wish to track moves more than a few hundred miles during
deployment then geolocation data you obtain will be very difficult to analyse. Recent
studies have used sea surface temperature records to help resolve locations for
seabirds, particularly latitude at times of equinox.
The geolocator on the animal must have a reasonably good view of the sky at the time
of dawn and dusk during the period that tracking is desired. Studies have determined
that this occurs on many birds often enough to get very good data. The aim is to
capture ambient light level measurements at these times. Two location fixes per day
are obtainable. Often, the cleanest data is obtained when a bird is flying. Shading,
cloud and fog are the main uncontrollable sources of error. Location fixing will only
be possible when there is a daylight period and a dark night period within any 24hrs.
Man-made light in urban areas may cause interference.
At times near equinox, latitude determination will not be possible. At all times,
latitude determination will be poor within the Tropics becoming worse closer to the
equator. Best performance will be obtained between the Tropic of Cancer and the
Arctic Circle, and between the Tropic of Capricorn and the Antarctic Circle. In
comparison, longitude accuracy is largely uniform (and invariably better than latitude)
between the Antarctic Circle and Arctic Circle.
Historically, most studies have been carried out on seabirds. This is probably due to
the large number of heavy seabird species capable of carrying attachments, ease of
tagging and recapture both in terms of finding the bird again (consistent breeding
sites) and ease of capture, large flying ranges and the pelagic nature ensuring distance
from man-made light sources and high probability of flight during dawn and dusk.
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Researchers are now finding success by putting our smaller loggers on songbirds.
Waterfowl (geese, swans, ducks) and seals are also species where good data has been
obtained.
Some instruments record wet/dry information to help determine the activity (and
location) of the bird. The wet/dry information works with salt water only, and the
logger must be leg mounted (unless diving is to be considered).

Which geolocator to use?
The geolocators available will change with time as we develop the technology – see
our website at www.birdtracker.co.uk. Which one you use depends on the species and
habitat. For help in choosing, contact James at jwf@bas.ac.uk.
Mk5, Mk7, Mk9, Mk15, Mk18, Mk19 are all potted in hard epoxy. This usually
makes them good for seabird deployment where they may encounter harsh wear and
tear. The Mk5 and Mk9 are now obsolete (replaced by Mk15) and we foresee that the
Mk7 will also be obsolete very soon (replaced by Mk19).
Mk13, Mk14, Mk10, Mk12 are encapsulated in a softer coating that makes the
devices light-weight but less rugged. Experience has shown that these devices are less
suited to seabirds where wear and tear from rocks, burrowing or repeated diving has
been thought to be responsible for ingress from seawater resulting in premature failure
of a higher percentage of devices. Many seabird studies have been successful with
their use, however, but failure rate is higher than with the larger loggers. We foresee
that the Mk13 and, perhaps, the Mk14 will soon be obsolete (replaced by Mk18).
The Mk7 is the biggest instrument having the longest life with temperature
measurement when wet. The Mk7/19 records the time of transition (3 second
resolution) between wet/dry states providing the new state lasts more than 6 seconds.
A state change of less than 6 seconds is ignored. The Mk7 wet/dry memory fills up
quicker than the Mk5, depending on activity, and may not have capacity for a full
year. It is hoped that the 50% increase in wet/dry memory with the Mk19 will allow a
full year of recording in most cases.
The Mk5 and Mk9 have recently been replaced with the Mk15. In function, this is
identical to the Mk5 in that it records the number of 3 second samples wet during each
10 minute bin (min 0, max 200).
The Mk14, Mk10 and Mk12 are available with the light sensor on a stalk. This is to
raise the light sensor above the plumage of the bird to minimise feather shading and is
intended solely for back mounting. Length and angle of the stalk depend on species.
Please examine the specification sheet for the geolocator in which you are interested,
available on our website. Make sure it will do what you want it to in terms of
longevity, temperature range etc. If you have any questions, please get in contact with
us. Our experience with different devices being used on different animals is growing
all the time allowing us to help you with your selection.
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How to attach the geolocator to the animal
Geolocators are usually used over long periods of time. Often, a moult can occur
during the period of deployment. If this is so then the methods of attachment are
usually limited to either a harness or leg attachment. Studies to date have shown that
leg attachment is better suited to seabirds while a leg-loop harness based on the
Rappole-Tipton harness is suitable for most terrestrial birds. For waders, it is not clear
yet which is better, and is species dependent. Use of leg mount should be avoided
with thin or weak legged birds.
Depending on species, attachment:body weight ratio for leg mounting should be kept
under 2% and preferably only 1% or less. The maximum ratio for back mounting is
considered to be 3-5%, depending on species. These are general figures; there is still
room for much research regarding the effect on birds of long term attachments.
There is no best method which will fit all circumstances; it is strongly recommended
that the user give serious thought to the attachment method. Any bird handling and
tagging must be done only after obtaining the relevant licenses, permits or
guidelines applicable to the area of study, as well as allowing any study to be
considered for ethical review. The British Antarctic Survey accepts no liability
for the use or misuse of any of the suggested attachments methods shown and
strongly recommends that small scale, careful acceptance trials be performed
before any large scale study.

Leg attachment
Historically, a leg attachment has been used where the instrument is attached to a ring
(e.g. Darvic or Salbex plastic) on the leg of the bird. The aim of any attachment is to
be of minimum size and weight, to cause as little danger to the tagged animal as
possible and not to affect its behaviour. It is paramount that the active part of the light
sensor faces away from the body of the animal and is not obscured. The light sensor is
the white component on the instrument.

Figure 2 - Mk14 showing light sensor position.

We have found that darvic plastic rings used with weather resistant, UV resistant
stainless steel barbed cable ties and, perhaps, self amalgamating tape to be the most
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useful combination in producing a reliable low weight attachment method (see below
for details).
The use of harnesses with seabirds over long periods of time has had mixed success
and, apparently (there is minimal documentation), the harness has often caused
damage to the animal.
Leg mounting suits geolocator attachment well as feathers tend not to obscure the
light sensor when the bird is in flight, sitting on water or standing. With some waders
or smaller seabirds, it might be preferable to mount the device on the upper leg rather
than the lower leg in order to reduce the loading. If this is done, ensure that the light
sensor is lowermost to reduce any shading effect from thigh feathers and the body of
the bird.
One of the most popular and successful leg attachment methods has been some
variation of a special cable tie to pass around the logger and through holes in a darvic
ring. This method is shown below. Self amalgamating tape is a very useful material
for ensuring the ties get a good grip on the geolocator and, to some extent, the leg
ring. However, barnacles have occasionally been found growing on exposed self
amalgamating tape on loggers after long deployments so it should be used minimally.
Some users use epoxy or cyanoacrylate glue in addition to the cable tie but note that
cyanoacrylate adhesives do not weather well and usually lose adhesion; they form a
poor bond on smooth plastic. They are good for a little protection or holding
something in place temporarily but are no good for permanent strong adhesion
between two smooth surfaces; marine epoxy is what is needed for that, or a roughing
up of the surfaces.
Self-amalgamating tape is not sticky. The only material it will usually stick to is itself.
To do this, you must stretch it as you apply it. Cut off a piece and play with it around
a pencil if unfamiliar with it. To ‘tie it off’, the end should be stretched and pressed
into position on a lower layer of tape for a few seconds using your fingers so that the
heat helps the bond. A short while after application, self-amalgamated tape cannot be
unwound but it can be carefully cut with a blade.
Avoid having tape or cable ties permanently touching the two contacts during
deployment. The edge of the tape/tie is more likely to ‘hold’ water when the logger
comes out of the water. This provides a conductive path and an erroneous ‘wet’
condition may continue for a short period after coming out of the water.
We use weather resistant, UV resistant nylon 6.6 cable ties with stainless steel locking
tabs available from RS (rswww.com) and Farnell (www.farnell.com). They are made
by Thomas & Betts, part number TY523MXR (black) (RS 666133, Farnell 1230926).
These are 2.3mm wide. For Mk5 and Mk7, longer ties will be needed with a greater
width (see TY524MXR, TY525MXR, TY526MXR). A cable tie tool from Thomas &
Betts (available through distributors mentioned) is useful for tightening the tie with
one hand (manufacturers part number WT1 (Farnell 1212511, RS 1588911)).
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Figure 3 - A now obsolete Mk3 attached to an albatross darvic leg ring using two cable ties. Two
holes per tie are drilled through the darvic material spaced a few mm apart. Loggers have
returned on birds after 6 years of deployment with this method.

Figure 4 - A Mk9 logger attached to a darvic with single and double cable ties. No self
amalgamating tape was applied here although a small amount is recommended.

Figure 5 – Mk7 loggers attached to darvics ready to be deployed onto Albatross. The attachment
on the right has too much self amalgamating tape applied for a seabird. Too much may block the
light sensor's visibility, promote barnacle adhesion and will reduce wet/dry accuracy if touching
the contacts as shown here.
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Figure 6 - A longitudinal way to mount the Mk9. This is a good solution as no holes are needed
in the darvic. Shown here is a Cook’s Petrel (photo courtesy of Matt Rayner).

Figure 7 – An example mounting arrangement for a smaller logger using 0.75mm thickness
Darvic, cable tie and self amalgamating tape.

Sharp edges of the Darvic should be rounded off before use. The height of Darvic
should be comparable to the length of the logger. The method of an overlapping
Darvic loop can be aided with a dab of adhesive under the overlap once on the bird
e.g. cyanoacrylate (e.g. Loctite 406) followed by a spray of activator to make it set
within a few seconds, or a better adhesive (such as a suitable waterproof silicone,
polyurethane, plastic bonding cement, marine epoxy etc) could be used which will set
much more slowly.
If you consider the pins too sharp, you may wish to round them down with a small
file, or encapsulate them in a drop of silicone sealant/epoxy. If you intend to use the
loggers only once for a single deployment then you could cut the pins flush with the
body of the logger after you have started the logger. When you recover the unit, wires
can be soldered onto the cut surface of the pins to attach the clips and download the
data. This reduces the risk of these pins snagging, becoming bent and causing water
ingress. Sea water ingress caused by physical damage is usually fatal to the device
after a short time.
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Figure 8 – Example attachment of a Mk15 on a large duck (Scaly Sided Merganzer). Photo
courtesy of Diana Solovieva,

Figure 9 – Example of a specially made plastic leg flag with two loops (for a wader). The white
ring was included as a spacer above the leg joint and the pins were cut down further than shown
here to reduce the risk of harm to the leg. The surfaces of the logger and plastic flag are first
roughened with sandpaper to enable cyanoacrylate adhesive (superglue) to form a good bond
after the thread is tied. Photo and details courtesy of Ron Porter.
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Figure 10 - Mk10 mounted on a leg ring of a Red Knot with light sensor downwards. Photo
courtesy of Ron Porter and Jan van de Kam.

Figure 11 – Example leg mounting of a Mk10 on Sabine’s Gull. Photo courtesy of Carsten
Egevang.
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Figure 12 – This photo was taken during an acceptance trial. The bird did not accept the device
well and so the study has been postponed until a lighter logger is available. This bird is too small
and the leg is too thin to leg mount a Mk10. Note, however, that weight could be reduced by
reducing the amount of additional glue shown here. A little stretched self-amalgamating tape
around the logger with a touch of cyanoacrylate adhesive would probably do as well to allow the
cord to grip, but be lighter. Keeping the centre of gravity as close to the leg as possible is
important to minimise loading.

Figure 13 – Example leg mounting of a Mk10 on a wader (Bar-tailed Godwit). Note that it is
probably better for the bird to mount the device on the upper leg of a wader, with the light
sensor downwards as shown here. Photo courtesy of Jesse Conklin.
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Back-pack mounting
Back mounting a geolocator on smaller birds can be the only sensible method of
attachment. Unless the plumage will not obscure it, the light sensor must be on a stalk.
The effect on aerodynamics, mating (e.g. consider a long pointy stalk in the wrong
place on the back of a female!), nest access (e.g. stalk may not be compatible with
cavity nesters) and mobility in dense vegetation must all be considered. The stalk
length and angle must be minimised to enable the sensor to be clear of plumage but to
present the least hindrance to the bird, physically and aerodynamically.

Figure 14 - Mk14-S has the light sensor on a stalk. This is designed for back mounting where the
sensor is required to protrude above the feathers.

At the time of writing, back-mounted studies have only been in progress a couple of
years and so it is too early to give definite recommendations. All studies known to the
author for small birds (e.g. songbirds, passerines) have been based on the RappoleTipton leg loop harness. Similar techniques to those used for attaching VHF tags have
been adopted with one big difference being the requirement that the tags stay attached
and not fall off after just a few weeks. This means that different materials must be
used.
Birds which put on a large amount of body mass (many migrating birds do, of course)
around the body where the harness would normally go must be considered carefully;
as should birds that are the ‘wrong’ shape. It has been suggest that many small waders
are not suitable for a leg loop harness because of their weight gain. Many other birds
do not change shape appreciably at the position where a leg-loop harness would sit on
their body and so are suitable.
The harness material must be chosen so that it is weather resistant and light weight
but not too fine as to risk injury to the bird through abrasion or cutting. Likewise, it
must not be too tight or too loose. PTFE ribbon has been used as has thick polyester
and Kevlar threads.
One sensible way to attach a PTFE ribbon harness to the geolocator is to sew the two
loops of ribbon onto the tag with multiple loops of thread tight around the tag and
through the ribbon either side. After tying off the knot, a small dab of cyanoacrylate
can be applied to keep it from coming undone.
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At the time of writing, the Mk12-S has not been released but a prototype (with overly
long stalk) is shown below. This will be our smallest logger to date at 0.9g for back
mounting (about the same weight as two paperclips).
It can be seen that the pins are now loops and a tube has been placed near the other
end to allow a thread to pass through. Even if the tube is not wide enough to take the
harness material, an additional thin piece of e.g. Kevlar thread can be passed through
and tied onto the main harness loops either side. This can be done before handling the
bird.
When the bird is in the hand, the metal hoops at the other end can be quickly used to
tie off each leg loop to the correct length if so desired. A little dab of cyanoacrylate
adhesive can be applied to each knot to help stop it coming undone if considered
helpful.

Figure 15 - The Mk12-S measuring 20x8x4mm and weighing 0.9g. The metal hoops and front
tube should simplify attachment when compared to the Mk10-S.

Although the weight of the Mk12-S is about 25% less than the Mk10-S, because of
the simplified attachment method, the aim is that the comparative overall attachment
weight will be reduced even more. With such low logger weights, the weight of a
length of thread or ribbon as well as a dab of adhesive becomes significant.
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Figure 16 - Leg-loop used successfully with a Mk13-S on Redshank. Note here that the self
amalgamating tape has not been stretched when applied. It does not matter too much here but
the best results are achieved when it is stretched. Photo courtesy of Raymond Klaassen.

Figure 17 – Returned Redshank wearing harness above after 1 year deployment. Photo courtesy
of Raymond Klaassen.
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Figure 18 - Purple Martin carrying geolocator using a leg-loop harness. The stalk was shortened
significantly for follow up studies. Photo courtesy of Timothy Morton and Bridget Stutchbury.

Figure 19 - Wood Thrush with Mk14-S fitted on a leg loop harness. The stalk is unnecessarily
long. Would a Mk14 (as opposed to Mk14-S) have sufficed? Probably not as the back feathers
and wings were often observed to cover the device; that would block ambient light and result in
poor data. Photo courtesy of Elizabeth Gow and Bridget Stutchbury.

Reliability
Due to design compromises necessary to make the loggers as small as possible, when
exposed to harsh environments, premature failure may occur. If they experience
temperatures far below their specification (generally -10’C), then it becomes more
likely that they will fail. Reliability of the geolocators on back mounted terrestrial
birds has been very good. The challenges come when leg mounting devices on
seabirds and burrowing birds.
Burrowing birds cause a lot of wear and tear to the device which can cause failure.
Sea water exposure along with general wear and tear can result in seawater ingress
18

causing failure. For best results, the heavier potted loggers need to be used in these
cases e.g. Mk15. The extra ruggedness comes at the expense of extra weight. The
harder, heavier potted loggers are less likely to be damaged than the smaller, softer
coated loggers. For back mounting, the softer loggers are at far less risk from physical
damage than with leg mounting.
Failure modes have usually been due to ingress or absorption of seawater resulting in
premature battery failure. Once the battery is depleted, data will no longer be written
to memory, and it will not be possible to download the logger using the interface box.
However, data collected prior to battery failure may be recoverable by us. If loggers
fail to download, return devices to us for possible data recovery. Note that this is a
process for which we may need to levy a charge, particularly if the temperature range
of the device has been exceeded, and successful data extraction is not guaranteed.

Other requirements
You will need an interface box to turn the geolocators on/off and to download data as
well as a PC. This connects to an RS232 serial port on your computer or, via a RS232
to USB converter, to a USB socket. The 9-pin serial interface box will soon be
replaced with a USB connection that installs as a virtual serial port. This will appear
on the host computer as a USB to serial converter. A terminal emulator, such as
Hyperterminal (if using Windows), can be run on the computer (details below) to talk
to the interface box. Alternatively, communication can now be carried out using the
latest version of BASTrak (‘Communicate’ front panel button); when asked to press
keys and type text, you must use the buttons and text entry at the top of the window
rather than direct use of the keyboard.
We supply additional software to process the data. When you recover the loggers at
the end of the study, you will download them as soon as you can with the interface
box, capturing the text output from the logger to a file. Our application BASTrak, is
used to decompress the raw data from this file and can be used to adjust for clock
drift. Any errors in the data will be reported. The ASCII comma separated variable
(CSV) files output can then be analysed as desired. You will need additional software
to do this. Commercial software called MultiTrace (Jensen Software:
http://www.jensen-software.com) is available but we also provide the TransEdit and
BirdTracker applications to our collaborators free of charge in order to perform the
conversion of light level data to location. Note that if you are using MultiTrace, you
will need to retard all sunset times by one record period (2, 5 or 10 minutes) due to
the nature of the logging algorithm in our particular geolocators where it is the
maximum light level during the period that is recorded.

Using the geolocators
When your loggers arrive and you have obtained the materials you need to employ
your chosen attachment method you are ready to begin. The geolocators should be
supplied to you asleep. The sleep state uses about 20% less power than the logging
state.
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If you have loggers left after your deployment and wish to use them the following
year then put them into the sleep state and keep them in the fridge until needed. This
will minimise battery discharge.

Communicating with the geolocators
Described here are instructions for using a PC/laptop running Windows with the
RS232 9-pin serial version of the interface box. Use of the USB version of the
interface box is identical to using the 9-pin interface box with a USB-RS232
converter.
When not using the interface box, connect the red and black clips together. This
minimises the risk of static damage to the device.
If you do not have a 9-pin RS232 serial port on your machine then you will need to
use a RS232 to USB converter (install the appropriate driver, which should come with
it on CD, if your version of Windows asks for it). For USB interface boxes, ensure
that you install the interface box driver by executing the ‘CDM 2.04.16.exe' file on
our CD before you plug in the interface box (this, along with the rest of the
installation, will be done by running install.bat). Contact us if you are unsure or need
a driver for an operating system other than Windows.

Figure 20 - Serial RS232 9-pin D-type port

You now need to establish which COM port you are using. For a standard 9-pin
RS232 serial port on your laptop/PC then this will most probably be COM1 or
COM2. If you are using a RS232-USB converter then the port may be anything from
COM1 or higher. Different USB ports may be assigned different COM numbers. The
way to find out is to look at the Control Panel for your Windows version (via the Start
button) and select System. Then select the Hardware tab and click the Device
Manager button. There should be an entry called Ports; click on the little + sign next
to it to expand it. This should display the available COM port numbers on your
machine. The USB to serial converter should be listed. (Different versions of
Windows may differ in the above procedure – you can thank Microsoft for that.)
Alternatively, you can always use trial and error.

Figure 21 – An example of a serial to USB adapter
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Once you have established the COM port you are about to use then you can
communicate. You will need a program called a terminal emulator or you can use the
‘Communicate’ button on BASTrak. With a Windows operating system, the program
Hyperterminal is a terminal emulator. This may be executed following Start ->
Programs -> Accessories -> Communications -> Hyperterminal. Unfortunately,
Microsoft no longer includes Hyperterminal in recent operating systems and so
BASTrak must be used.
Hyperterminal will ask you for a name e.g. geolocator. Select the COM port you have
established that you are using. You will get a window asking for Port settings. Use the
following values:
Bits per second (also known as baud rate): 9600
Data bits: 8
Parity: None (or N)
Stop bits: 1
Flow control: none

Figure 22 - Interface box connected to a geolocator.

Now connect your interface box to the serial port. You should see a welcome
message. Follow the instructions that appear in the communication window and
connect a geolocator. With some loggers, the black clip connects to the pin labelled
‘BL’ or ‘B’ and the red clip to the ‘R’ or ‘Red’ (if visible). If you find you get a BAD
CONNECTION message then it could be due to a number of reasons:
•
•
•
•

You have connected the geolocator around the wrong way (this will not
damage the device – simply swap the clips and try again).
There is some transparent encapsulant (left over from manufacture) or other
deposit on the pins of the geolocator – clean/wipe/scratch this off and try
again.
The device is dead – return it to us for possible data retrieval.
The interface box is dead – return it to us for replacement.

Please note that for newer versions of our devices you may have to wait up to a
minute before a successful connection message is returned. For older devices, a
message should come back within a few seconds.
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Important note: do not leave the 9-pin interface box connected to your laptop/PC
during power cycling/rebooting of the laptop/PC. This will not cause damage but, the
communications port that the interface box is connected to will fail to work until you
disconnect it and perform another power cycle/reboot. There is no problem with
leaving the newer USB interface box design connected.
If, at any time, the screen freezes or no instructions appear, try first disconnecting and
then reconnecting the interface box from the end of the cable.

Starting recording
Geolocators are in two states: recording or sleeping. Both states use power (there is no
room for an on/off switch) They can be switched from one state to the other as many
times as desired but only the current deployment record is accessible and cannot be
downloaded once asleep.
Recording is started by communicating with the interface box and answering the
questions asked by the interface software. Data is only retrievable when the logger is
recording. An absolute time reference is not recorded by the logger and so, when you
start recording, you must make a note of the date and time somewhere safe; accuracy
to the nearest minute is acceptable. Use an accurate clock such as a GPS receiver; it is
unwise to use your PC clock as this is often inaccurate. We strongly advise that you
use Greenwich Mean Time (GMT or Zulu) in all of your work to avoid mistakes (if
you like, write down local time also for verification). You will use this time when you
process the data at the end of the study, along with the download time, to adjust for
clock drift. A mistake with the time zone will completely ruin the data analysis (the
mistake can be corrected and the data reprocessed but only if the amount of time error
is known).
You do not need to start the loggers in the field; due to their long life, they can be
started many days before deployment. This may make things easier as then no
computer is needed in the field.
There is no way of knowing if the logger is recording other than by communicating
with the unit. Under normal circumstances, once started, there is no need to
communicate with the geolocator again until after recovery from the animal but, if
you ever want to check to see if a geolocator is recording, connect to it using the
interface box. It will tell you the status and, if recording, how long it has been
recording.

Calibration
If you have time before putting the loggers on your target animals then you should
perform a calibration with every logger (this is also known as ground truthing);
individual variations in the units may cause slight variation in light level sensitivity
and calibration of sensitivity is necessary to compensate for habitat shading (through
foliage or cloud, for example).
The aim is to record and identify the light level that corresponds to a certain sun
elevation as experienced by the light sensor on the bird in its migratory habitat. This
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light level threshold-elevation pair of values will then be used when you process the
data. Ideally, the calibration data should be recorded with the logger on a bird in its
average migration habitat that is stationery for a number of days (often impossible).
Immediately after deployment may be the best calibration time provided that the
habitat is representative of the migration route and that the bird stays very close to the
release location for a number of days. The second best situation is to gather data from
unattached devices in advance of deployment at a site with similar habitat and
weather conditions to those that will be encountered during migration. The third best
option is to gather a few days of data in an open situation at any known location.
Start the geolocators recording and put them at your calibration site (they must
experience daylight and dark nights) for about a week. This will record suitable
calibration data. Make a written record of when you put them out, when you remove
them and the location latitude and longitude of the calibration site (+/- 0.01 degrees).
If the loggers are not attached to the bird, then it is important that the light sensors
point upwards toward the sky and there are no bright man-made light sources nearby.
If you are not aiming to mimic real life habitat (third option above), or are studying
seabirds, then it is also important that there is minimum shading and that a good view
of the horizon is provided. Avoiding mountains or hills on the horizon is preferential,
particularly in the East and West directions. The roof of an un-shaded building or the
open area on the top of an un-vegetated hill may be suitable locations.
If you know that your study species will experience different habitats at different
times of the year resulting in a significantly different amount of foliage-shading then
different thresholds can be used during post processing to analyse different portions of
data. The more you know about the bird’s habitat, the more you can get out of the
geolocator results.
It is of benefit to keep a record of the cloud cover and weather conditions at times of
dawn and dusk at the chosen location over the calibration period. Noting snowfall
events during this period is important along with anything else occurring which may
obscure the light sensor at these times. This information can be used later during
analysis and, at the very least, will familiarise you with the effect weather can have on
the attenuation of light levels recorded and the associated errors in location that result.
If you have insufficient time to perform the calibration before animal deployment then
the calibration can be done afterwards. Ideally, both pre and post deployment
calibration is performed but, this is not usually necessary. Pre calibration is preferred
to post as the geolocator may die during deployment making post calibration
impossible. Calibration is unaffected by proximity to equinox. Geographic location is
not really important, other than the aim to match average weather and (for terrestrial
birds) shading habitat and to ensure there is night and day.
Follow the instructions above to communicate with the geolocators and start them
recording when prompted with the question. Once you have recorded your calibration
data, you can move them onto your target animals (if not already). There is no need to
download any data at this stage but you can connect them up to see that the timer is
still running to assure yourself they are still ok if you like. The calibration data will be
offloaded along with the deployment data after recovery.
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If, for logistics reasons, there will be many months between calibration and
deployment then you may wish to download the calibration data soon after calibration
and then send the logger to sleep in order to maximise the memory available during
deployment. If the logger is sent to sleep, the data that has been recorded can no
longer be accessed (unless you send the device to us before starting it again) so it is
important that you have verified saving of the calibration data in this case. Shortly
before deployment, you will then need to restart the loggers in the normal way, taking
a written note of the start time, as usual.

Figure 23 - The surface of this logger has become more opaque due to staining with time. This
logger was only out for a few months on a Goose leg in the Arctic tundra. It shows why a postdeployment calibration as well as a pre calibration is sometimes necessary due to the increased
light attenuation from the casing as a result of the staining.

The figure shown above shows a returned logger having been out in the field on a bird
spending a few months in peat tundra. The surface above the light sensor has become
more opaque with time and so the sensitivity will have decreased with time. A pre and
post calibration would be useful for best analysis of results. Assuming that the
obscurity by staining has occurred linearly with time, then the data could be split into,
for example, three bins and the appropriate calibration value applied (i.e. near the
start, use the pre calibration value, and near the end, use the post calibration value
while, in the middle, use a value in between). Alternatively, an automated method
could be developed to use a calibration value interpolated linearly between the pre
and post calibration values.

Deployment
After you have started the geolocators and recorded the calibration data, you are then
ready to attach them to your animals for deployment.
For each study, you may want to make a summary spreadsheet for the following
metadata; the most important items are in bold. (When recording GMT time by taking
or adding hours from the local time zone value, be sure to take into consideration the
crossing of the date line when recording the date; to be sure, we advise you to record
both local and GMT time and date for recording start):
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•
•

•
•

Logger serial number
Start of logging date & time (to be sure, write down local and GMT time & date)
Beginning of pre deployment calibration date & time
End of pre deployment calibration date & time (this is not stopping the logger
but is the removal of the logger from the calibration location, if applicable)

•
•
•
•
•
•

Deployment date & time
Recovery date (unnecessary but important for study report)
Download date & time (unnecessary but may be useful to corroborate download data)
Beginning of post deployment calibration date & time (if performed)
End of post deployment calibration date & time (if performed)
Notes (e.g. unusual appearance of geolocator after deployment)

You must also have a record of:
• Pre deployment calibration location: (lat & lon, if performed)
• Post deployment calibration location: (lat & lon, if performed)
Note that if you stop logging at any time before deployment for whatever reason, then
you must record the time and date again when you restart the logging for deployment.
Save these records somewhere safe and return to them when you recover the
geolocators from the animals a year or so later. As indicated elsewhere, the time zone
you use throughout the study is critical and, to avoid problems, we recommend using,
at least, GMT for all records.
We also recommend collection of additional metadata relating to e.g. colony
attendance (e.g. first and last sightings at the colony, foraging trip durations), breeding
phenology, failure dates, individual age, sex and breeding status in each season etc. to
aid interpretation of the final results.
Also, please do consider something that can be forgotten: control data! At the very
least this could include identification rings for untagged birds. At a breeding colony,
the number of control birds you get back compared to the number of tagged birds
returning should tell you how much harm is being caused by the extra burden of the
tags. This will help us all improve the welfare of future tagged birds as it will help us
refine the attachment method and evaluate species specific maximum load.

Downloading the data
When you recover the loggers at the end of the study, download them as soon as you
are able to using the interface box. To download, follow the communication
instructions above. When you are asked if you want to download the data you must
start ‘capturing’ the text from the terminal emulator program (BASTrak
‘Communicate’ should do this automatically). You are reminded to do this by being
asked if your computer is logging the session.
To capture the text in Hyperterminal to a file, select Transfer -> Capture Text from
the menu bar. Choose a unique file name. This will open a .txt file of this name and
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all future text in the communications window will be recorded to that file. (Note that
if you use the same filename more than once, additional data may get appended.)
You will then be asked to input the current time and date (GMT) (you may also wish
to take a record of this manually). Please note that the date and time must be input in
the instructed format. If you make a mistake and need to press the backspace key you
can do so but you will need to edit the .txt file afterwards as the backspace key does
not have the effect you desire. The backspace key press is actually saved as a
character in the .txt file and does not delete the previous character typed. However, it
is easy to edit the .txt file using Notepad or some other text editor after you have
finished capturing all the data to make the date and time format as it should be.
Downloading can take about 20 minutes per year of data (for 10min records) or much
less if there is no wet/dry data. Ensure the connections are not disturbed during this
time; no error may be displayed if there is a brief interruption to the data, so this is
very important. When the data has finished downloading, you will be asked to enter a
line of text. This is simply for you to add notes to the data if desired; no entry is
necessary. You can now turn off the capture text option by selecting Transfer ->
Capture Text -> Stop (BASTrak ‘Communicate’ should do this automatically). It may
then be advisable to open up the text file in any text editor (e.g. Notepad), and doublecheck that everything has been recorded properly, and that the data matches with the
filename etc.
Note that sending the logger to sleep will automatically result in you not being
able to access the data anymore so it is imperative that you have captured the
downloaded data properly. If you do not need to redeploy immediately then do
not send the device to sleep until you have done the decompression. This will
allow you to download again should you find problems.
Data is not deleted from the geolocator after download, and recording will continue
until you tell it to stop or the battery expires. Therefore, if you have a problem with a
download, try again.
Consider whether you want to do a post deployment calibration or not. If you find the
light sensor has become opaque or obscured then we would recommend it (see
calibration section above).
Please note that during download, the internal timer continues but data is not
recorded. The geolocator does not save records when it is busy downloading. Thus,
during download time, the logger may ‘miss’ a record. If the logger is downloaded
and then downloaded again, there may be one or more missing data points when the
second downloaded file is analysed, corresponding to the time of the first
downloading. This will be highlighted as a missing sample error message. This will
invalidate the two days worth of data at this time and marked ‘SUSPECT’ (though it
can be corrected if you want to edit the data).
If you are not intending to redeploy loggers, there is no reason to send the logger to
sleep, and therefore data can simply be retained in the logger memory as a back-up
(until the battery eventually fails).
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Figure 24 – An example of downloading in the field. With short deployments, download may be
quick enough to be accomplished with the geolocator on the bird. ‘Live’ downloads can be handy
for short pilot or trial studies and to get a feel for calibration and location error for habitats such
as forest shown here. Photo courtesy of Tyler Done and Bridget Stutchbury.

27

Instructions for BAS geolocator data post processing
using BAS software
Known bugs
BASTrak
1) Windows regional settings must have decimal symbol set as . (full stop)
and not , (comma). For XP, Start -> Control Panel -> Regional and
Language Options -> Regional Options tab -> Customize.

TransEdit
1) TransEdit.exe does not work from networked drive; it must be executed
from the local drive.
2) Does not perform transition calculation using different values for sunset
and sunrise thresholds so set to the same value before transition
calculation.

BirdTracker
1) Heading value is incorrect – ignore it. Distance value is incorrect – ignore
it. Sorry, you will have to work these out yourself.
2) BirdTracker.exe does not work from networked drive; it must be executed
on the local drive.
3) Tracks crossing the 180th meridian do not visually wrap around correctly.
4) Movement compensation algorithm can be improved by calculating
average longitudinal speed based on next position as well as previous
position. Various extensions and iterative smoothing methods are often
used additionally, as required.
3) Compensated latitudes are calculated using nearest last position (be it a
midnight or noon) regardless of whether midnight, noon or both is
selected.
4) A time of 24:00 may be output in the .trj file. This causes a crash when the
compensated values are calculated. As a crude work around, identify the
problem day from examining the .trj file and change the corresponding
sunrise or set time by +/- one minute in the .trn file.

Installation of software
The software is for Microsoft Windows operating systems. To install BASTrak, insert
the software CD and the installation program should start automatically. If it does not,
then run the install.bat file. After installation, the programs should be accessible via
Start -> Programs -> BASTrak along with the manual.
TransEdit.exe and BirdTracker.exe require the Windows .NET framework to be
installed on your machine first. This should happen automatically if install.bat is run.
To perform this manually, run the file dotnetfx.exe on the CD. If the only choice you
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get by this .NET installation program is to Repair or Uninstall then you already have
.NET on your machine and you should press cancel, otherwise, follow the installation
instructions.
No GIS (Geographic Information Systems) tools are included as these are outside our
scope. However, many GIS tools are available. A free one can be found at
http://www.seaturtle.org/maptool. Additional tools will be required to smooth the data
in whatever way you see fit.
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BASTrak
The BASTrak program is a tool for decompressing the data downloaded from BAS
geolocators and also for communicating with them. It produces comma separated time
stamped ASCII data files where each record is on a separate line. Errors are also
reported on separate lines.
Instructions on how to use BASTrak are obtained by pressing the help button in the
program (this is also accessible as the ‘BASTrak Manual.txt’ file on the CD). After a
logger has been downloaded and the data saved as a .txt file using a terminal emulator
(or the ‘Communicate’ option), you should process it using this program.

Clock drift
One problem resulting in increasing error as time goes by is clock drift. While latitude
depends on day-length, longitude depends on local noon with respect to a known
clock. If the clock on the geolocator is not exact and drifts slightly over time, the
longitude coordinate will also drift accordingly (latitude will be largely unaffected).
Clock drift depends on clock crystal manufacturing inaccuracies and, predominantly,
temperature. It is usually acceptable to average the drift linearly over the whole
deployment; which is what BASTrak does if you perform a drift adjustment. You will
need to enter the start time of the logger which is why writing down the exact time of
the start of logging is important, as the logger does not save this value internally.
Clock drift from our loggers should be no more than about 2 mins per year. The
further away the ambient temperature during deployment is from 25’C, the more drift
will occur.

Calibration data processing
The bottom part of the ‘Location Aid’ feature of BASTrak enables the user to obtain a
sun elevation value corresponding to the sunset and sunrise thresholds for calibrated
data. This pair of values is essential in processing the data; it is what defines the
‘sunset’ and ‘sunrise’ time. The TransEdit program should first be used to analyse the
calibration data and obtain sunset and sunrise values corresponding to a chosen
threshold value. The aim is to match the threshold value to a Sun elevation angle of
about –5 degrees when the light level is changing most rapidly. Data will be most
immune to interference when the light level is changing most rapidly.
Choosing a threshold value half way within the light range is often suitable (32). Look
at the calibration data using TransEdit and note the dates and times of sunsets and
sunrises corresponding to this chosen threshold. Putting those times and dates into the
bottom part of the Location Aid window allows you to get corresponding Sun
elevation values. This allows you to see the variation (mostly due to weather) during
the calibration period. Ideally, the same sun elevation angle should result in the same
light level value each day.
The ‘sun elevations from .trn’ facility automatically produces elevation values for all
transitions in the file using the position coordinates input. A .ele file is output
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containing the sun elevation value for each transition as the last field of each line. You
will need to process the calibration part of your data in TransEdit before you can use
this. It will be quicker if you cut out the calibration period from your .lig data and
save it as a new .lig file to work with in TransEdit.
You can compare weather conditions (if recorded) and decide on calibration values to
reject or keep on that basis. What you are aiming for is the ‘average’ weather
conditions during deployment on the animal. Of course, this is impossible to know
without attaching a weather station to your animal but your aim is to get as close as
you can. After rejecting any unwanted values, you should calculate the average sun
elevation angle corresponding to your chosen threshold level from all your valid
sunrise and set events. (If you find that elevation angles for sunrises are consistently
offset from elevation for sunsets then double check that you have used GMT times.)
Selecting a sun elevation value of –5 degrees is not too critical. Anywhere between –6
and –3 degrees should certainly be fine. A threshold level too high is more likely to
get interference from the animal. A threshold level too low will, possibly, get
interference from man-made light sources or the moon. One of the quickest methods
of data analysis is when a very low value of light level is chosen as the threshold (e.g.
1 or 2) as this will reduce the chance of false transition times being automatically
determined by shading events. However, this is probably not the best threshold to
choose as the greatest rate of change of light level may occur above this value. After a
while, you will decide on your own strategy.
Although we do not recommend making the assumption, to save time, you may find
that you can use the same Sun elevation and threshold pair values for all your loggers.
When you have decided on your pair of values, your chosen threshold level needs to
be entered into the TransEdit program (in order to tag rise and set times) and the
corresponding Sun elevation angle you calculate is needed by the BirdTracker
program (to perform the astronomy calculations for these rise and set times to get
location).
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TransEdit
The TransEdit program is a tool for analysing the decompressed .lig data file
produced by BASTrak in order to identify sunrise and sunset times. ASCII transition
files (.trn) are output where each line contains a record for a sunrise or sunset event in
chronological order.
The determination of the sunset and sunrise times is, by far, the most difficult step in
post processing and contributes most error.

File -> Open logger file (choose the .lig file to work with)
The TransEdit window is divided into three data viewing windows, with a control and
text information display window at the bottom. The three charts show the same data
set but the user can display the data over three different time periods. These time
periods can be adjusted on the right of the corresponding chart. The reason for the
multiple views will become apparent as you process data. The Next and Previous
buttons are useful for stepping through the data in large steps. Likewise, the Back to
Start and Go to End buttons towards the middle bottom of the screen can be used. To
move backwards or forwards fixed amounts, the Backward and Forward buttons can
be used at the bottom left of the screen.
The charts show the light data (0 to 64); daily cycles of day (64) and night (0) should
be observable.
The current position (cursor) is shown by the red line and the corresponding time
record at the top of the chart. Clicking the mouse anywhere on the charts will move
the cursor to that position.
The Current light value gives the light value at the current cursor position.
Any data in the .lig file marked ‘SUSPECT’ is charted in yellow.

Interpolations -> Linear
The raw data input for most devices is at 10 minute intervals. By performing this
function, the data is linearly interpolated into 2 minute samples resulting in smoother
curves. Higher accuracy is unnecessary considering other errors (e.g. cloud cover).
Now you need to input your threshold value for the light level value corresponding to
a sunrise or sunset (found from your calibration data). Let us, for example, use the
value 32 (half way) for both. Enter 32 into both the Sunrise threshold and Sunset
threshold boxes near the bottom left of the screen.
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Figure 25 - A sunset curve before and after interpolation.

Transitions -> Transitions calculation
The program has just processed all the data and wherever the data has a positive
gradient and crosses the Sunrise threshold value, a sunrise transition marker (yellow)
is drawn. Likewise, sunset transition markers (blue) are created for falling light levels
crossing the Sunset threshold value. Usually, the threshold values are made the same.
For ideal data, you have now done all the processing necessary to produce the sunset
and sunrise times. Unfortunately, data is usually far from ideal and needs further
processing. Each individual sunrise and sunset curve should be visually considered for
acceptance and an appropriate confidence level set.
To reset all the transitions at any time, use Transitions -> Reset All transitions. A
history file is kept of all commands carried out during a session (see below).

Figure 26 - Sunrises are marked with a yellow vertical line and sunsets with a blue vertical line.
The red line shows your current cursor position and corresponds to the time shown above it. The
data shown here is ideal with no visible interference near sunset or sunrise; the confidence
figures assigned should be high.

Filters
Before stepping through and viewing each sunset and sunrise curve individually, you
may be able to apply some filters to help you. These are found under the Filters
heading. When a filter is applied, all transitions found to be true for the particular
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filter rule will be given the confidence level you input. Confidence levels range from
0 to 9 and can be used to mark sets or individual transitions. The confidence tag is
transferred to the resulting location fix output by BirdTracker. For example, if we
wanted to give all locations calculated within 10 days either side of the equinox a
confidence value of 5 then we apply the Equinox transitions filter. Transitions within
a given confidence range can be deleted using the Delete low confidence function.
The filter functions are described below.
For example, let us use a couple of filters now. Filters -> Minimum dark period. Enter
a value of 4hrs and a confidence level of 0. Now use Filters -> Delete low confidence,
and use a range of 0 to 0. We have just deleted all those transitions found true for the
Minimum dark period filter rule. In this way, we can quickly remove a lot of noise
due to shading.

Figure 27 - A day when the geolocator experienced many shading events.

Figure 28 – The same day after applying the minimum dark period filter and deleting the low
confidence values. The sunset event is certainly unusable and should be rejected but, the sunrise
event may be valid; the data analyst must decide on a confidence level to assign. Given the high
degree of shading nearby, the confidence figure should be low in this case.

Editing
To edit transitions manually (move, delete or insert them), you can use the <
Transition > buttons to jump forward or back a transition. Clicking Delete this
transition will delete it and jump you forward to the next one. You can apply
confidence values to the transitions and can jump to the next transition having a
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specified confidence level. The latter is useful for checking the results of filters before
the transitions are deleted.
You are encouraged to consider each and every sunrise and sunset curve for validity;
if in doubt, delete it or give it a low confidence value.

Figure 29 - This is perfect data from a swan during migration. It is very clean and needs very
little editing.

Figure 30 - Data from the same swan before migration. Much of the data is usable. Note a light
source during the night; this may be the moon or a man-made light.

Figure 31 - Data from the same swan before migration. The data here is too shaded to be of much
use for confident location determination.

Filter functions in detail
The filter functions were designed to speed up post processing. They enable quick
processing of the data at the cost of lost information. The more you want from your
data, the more meticulous you will have to be when analysing the sunrise and sunset
curves and applying individual confidence figures.
For lowest uncertainty, any curve showing noise in the vicinity of the curve should
have the corresponding transition rejected.
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Minimum daylight period
Rule: Start at the beginning of the data. For every sunrise at time Ta, locate the next
sunset, Tb. If Tb-Ta is less than time x, then set the transitions at Tb and Ta to
confidence level y. Move to next sunrise after Ta and continue until the end of the
data.
The aim of this rule is to reject false transitions caused by light sources other than the
direct sun (e.g. moon, man made lighting). This is a rarely used filter as erroneous
light values during the night are usually rare. It is unwise to perform this rule before
the Minimum dark period rule has been applied as perfectly good transitions will be
assigned this confidence if there is a shading event within the previous (for sunsets) or
next (for sunrises) x time period (this happens quite frequently).
Be careful if x is less than your minimum natural daylight period (e.g. near the poles)
as those transitions will be deleted.

Minimum dark period
Rule: Start at the beginning of the data. For every sunset at time Ta, locate the next
sunrise, Tb. If Tb-Ta is less than x then set the transitions at Tb and Ta to confidence
level of y. Move to next sunset after Ta and continue until the end of the data.
It is usual to use the Delete low confidence function after this rule is applied.
The aim of this filter is to reject transitions caused because of shading by the bird.
There is a risk of deleting good transitions if there are threshold crossing moonlight or
man-made light events at night within x of the good transitions; beware.
Be careful if x is less than your minimum natural dark night period (e.g. near the
poles) as those transitions will be deleted.

Wrong crossing
Rule: For any sunrise at time t not having a 0 light value in the interval t-x or have a
64 light value in the interval t+y, assign confidence value z. For any sunset at time t
which does not have a 64 light value in the interval t-y or have a 0 light value in the
interval t+x, assign confidence value z.
The aim of this filter is to reject transitions which change very slowly i.e. have been
interfered with (shade, etc).

Noisy transitions
Rule: Let y(time) = light value, and T be the sample interval. At sunrise time t, for
every sunrise which does not have y(t)>y(t-T)>y(t-2T)>y(t-3T)....until y(t-nT)=0 or
does not have y(t)<y(t+T)<y(t+2T)<y(t+3T)....until y(t+nT)=64, assign the
confidence value x. For every sunset at time t which does not have
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y(t)>y(t+T)>y(t+2T)>y(t+3T)....until y(t+nT)=0 or does not have y(t)<y(t-T)<y(t2T)<y(t-3T)...until y(t-nT)=64, assign the confidence value x.
In summary, for a sunset, if the gradient (dy/dt) becomes positive, then mark that
transition. For a sunrise, if the gradient becomes negative, then mark that transition.

Equinox transitions
Rule: For any transition within the period equinox-x and equinox+x then apply the
confidence, y.
It is useful to perform this filter a number of times. For example, set a confidence
value of 7 for 20 days either side of the equinox. Then set a confidence value of 5 for
10 days either side of the equinox. Then set a confidence of 3 for 5 days either side of
the equinox. When you come to graph the resulting location fixes, you will be able to
quickly switch between viewing data at the different confidence levels.

Retard sunsets
When this filter is applied, all sunset transition values are retarded by x minutes. The
transition file is then immediately saved. It is strongly suggested that the user gives
the filename an ‘r’ suffix. The retardation does not affect the data shown on the
screen, only that which is saved to this file.
This filter is necessary because of the way the BAS geolocator records light level. It
records the maximum light level over e.g. a 10 minute period. For a sunrise, this
means that at the time the record was saved, the light level will be valid as the light
level is increasing. However, for a sunset, light level is decreasing, so a recorded
value at time t (the maximum light level recorded during the 10 minutes before time t)
will, in fact, have occurred at time t-10 minutes.
It is suggested that this function be performed at the very end of a processing session.
It will be this saved r file which you use in the next program. Before ending an editing
session, it is also strongly recommended that you also save the file (without the r
suffix) in the normal File -> Save transitions manner so that you can edit it later. It
would be undesirable to edit a retarded .trn file since there is no automatic way to
advance the sunset times 10 minutes.

Delete low confidence
This function removes all transitions having a confidence level within the range you
specify. Although you can manually assign confidence values, it is usually used after
applying one of the other filters.

Recent transitions table
This gives times of the transitions in the few days preceding and following the cursor
position. It is a useful way of tabulating the transition times to spot any oddities and to
get an idea of noise/reliability of the data.
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Saving files and history log file
Saving a retarded transition file is mentioned above. This is the file you will be using
with the next program, BirdTracker. To save a transition file (.trn) part way through
editing (regular saves are recommended) or when you have finished, use File -> Save
transitions file. To re-edit the file at a future time, you will need to first load in the
related .lig data file and then load in the transitions file (the related .lig file can be
found by examining the associated log file). It is suggested that the TransEdit program
is kept on screen when using BirdTracker as a few iterations between programs may
be necessary to delete missed erroneous transitions. However, it is best to thoroughly
edit the light data on its own merit first before looking at the location fixes it produces
to avoid the inclination to make things look ‘unscientifically nice’.
A feature of TransEdit is that a main.log file is produced which records most of the
automated procedures carried out by the user on a data file. When the .trn file is
saved, this log file is copied and saved with the same filename but with a .log suffix.
This is useful for repeatability and so that a history of post processing is known (also,
it records the .lig filename which the .trn file is based upon).
The log file is limited as it will not record manual editing performed by the user.
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BirdTracker
This program converts the sunrise and sunset transition data (.trn file) into location
data (.trj). In any 24hr period, a maximum of two location fixes may be obtained; one
is based on local noon and one on local midnight. A consecutive pair of transitions is
always needed to calculate a location (e.g. for a given day, if the evening sunset
transition is missing but that morning sunrise transition exists, no noon location fix
can be determined, and no successive midnight location fix can be determined).
Confidence values assigned in TransEdit will transfer to the corresponding location
fixes (the lesser of the two transition confidences will be used).
Calculate -> Trajectory to load in the .trn file. Make sure your .trn file has retarded
sunset data (saved with an ‘r’ suffix if you put it on) for BAS geolocator data. You
will be asked for a Sun altitude. This is the sun elevation angle corresponding to the
threshold value you used in TransEdit, which can be obtained using your calibration
data as described above (usually about –5 or so).
Click on Both and Compensate movement.
You can decide to show only locations calculated using sunrise and following sunset
(noon), or sunset and following sunrise (midnight) if you wish. For example, if you
know that a bird flies mainly during the daytime, then using the midnight values may
give you more accurate results. Usually, selecting Both is desirable.
The Compensate movement box is always best turned on. Once the transition times
have been converted into locations using astronomical formulae, this function
compensates for bird movement. For example, a bird flying west will see a longer day
period than a static target at a point half way through its journey, because it ‘follows’
the Sun. Therefore, the latitude calculation needs to be compensated depending on the
change on longitude. See below for details. The compensation assumes the bird has
been moving uniformly between sunrise and sunset (noon data) or sunset and sunrise
(midnight data) and is based on the last plotted point (therefore, if the last point has an
erroneous longitude value then the next point will be poorly compensated). The
option exists for the user not to use compensation if a better movement compensation
method is available. Both compensated and non-compensated data are recorded in the
.trj file (see below).
Data within the desired confidence range is shown according to the confidence range
selected on the right of the screen. Data can be stepped through backwards and
forwards with the track highlighted.
The map overlay exists for indication only; the software was never intended for visual
mapping and is severely limited. Left mouse click to zoom in, right mouse click to
zoom out.
One or more points can be selected or deselected by using shift+left mouse click.
Select all and Unselect all buttons are provided with Show selected only and Show
unselected only tick boxes.
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At any time, the data points shown can be saved in a file using File -> Save trajectory
shown. This is useful for saving only location fixes above a certain confidence figure,
for example, or within a certain time period.
Distance, heading and velocity are relative to the last fix of the type selected (e.g. if
noon only selected then distance from last noon fix is given). The Show period fields
can be used to display a limited time frame only.
For your final processing, smoothing of the data is usually necessary (averaging more
than once is often done). There is no function to perform this within BirdTracker.
Another step commonly used in analysis is to reject of those locations exceeding the
maximum speed of the animal.

Movement compensation
When movement compensation is turned on, the program does the following:
Current position at time&date t2, at longitude2 and latitude2
Previous position is at time&date t1, at longitude1 and latitude1
(Longitude East is -ve, West is +ve)
length = length of time between the two transitions making up the current position
calculation (i.e. daylength or nightlength) (i.e. time&date of sunset - time&date of
sunrise for a noon, time&date of sunrise - time&date of sunset for a midnight)
For every position, m = ((longitude2 - longitude1)/(t2 - t1))*(length/15))/2
m is the amount of time to take away or add on to the sunsets/sunrises in hours (the
sun moves 15 degrees West every hour)
For noons, recalculate latitude using sunrise+m and sunset-m.
For midnights, recalculate latitude using sunset+m and sunrise-m.
In effect, the longitudinal speed is first calculated since the last position. Assuming
the bird moved at this speed during the day/night length between the two transitions
used for the current position, the time gained/lost (West/East) due to this movement is
subtracted/added to the day or night length and the latitude recalculated. The
compensation is not perfect and is approximate. An improvement would be to
calculate average longitudinal speed using not only the previous position but the next
position, also.
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Figure 32 – Bewick’s Swan data shows animal flying West from Russia in Autumn. The top plot
is without movement compensation and the bottom is with. Cyan - noon positions; Dark blue midnight positions, Yellow - both positions.

Shown above is some data from a Bewick’s Swan. The data shown is a period when
the animal was travelling West to its Winter grounds in the UK in October/November
(Northern hemisphere). The journey was over land close to the coast. As can be seen,
there is a large difference between positions calculated using local noons and those
using local midnights, unless movement compensation is on. During the two periods
of rapid movement shown (averaging 15-20nm/hr), the midnight positions are higher
in latitude than they should be and the noon positions are lower than they should be.
This is because a fast Westerly movement implies longer day length and night length.
Longer day length for a noon position will produce lower latitude. Longer night
length for a midnight position will give higher latitude.
The obvious latitude error in the midnight value just before the stopover shown would
reduce by making the compensation improvement of estimating longitudinal speed
using the next position as well as the previous. The inaccurate value at this point is
due to the compensation routine calculating speed higher than it should be (because
the bird has just come to a stop) and reducing the night length by too much. In the
northern hemisphere, positions calculated with shorter night length imply lower
latitudes. Likewise, the night position just before moving on from this stopover has a
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higher latitude than it should due to the speed not being calculated high enough
because the bird was reasonably static at the previous position.
Note that a similar effect to movement compensation will result if the data is averaged
(‘smoothed’), provided that no transitions have been rejected and the animal travels
equally far between dawn to dusk, and dusk to dawn.

Datafile fields
Output from BASTrak (.lig)
Each line represents a ten minute period. Errors are shown on additional lines.
<ok/suspect>,<DD/MM/YY hh:mm:ss>,<seconds reference>,<light>
where
<ok/suspect> indicates whether the data is ok or suspect
<DD/MM/YY hh:mm:ss> is the time stamp
<seconds reference> is another way of representing the time; it is the number of
seconds elapsed since the reference chosen when the file was processed
<light> is the maximum light value measured during the previous 10 minutes

Output from TransEdit (.trn)
Each line represents a transition (sunrise or sunset).
<DD/MM/YY hh:mm:ss>,<transition>,<confidence>
where
<DD/MM/YY hh:mm:ss> is the transition time
<transition> is either Sunrise or Sunset
<confidence> is the confidence value (0-9) assigned

Output from BirdTracker (.trj)
A header line is the sun elevation angle used.
Each line represents a location.
<fix type>,<DD/MM/YY>,<mid value hh:mm>,<mid value secs>,<transition
1>,<transition 2>,<stationery latitude>,<compensated
latitude>,<longitude>,<distance>,<heading>,<velocity>,<confidence>
where
<fix type> is noon if fix was obtained using sunrise followed by sunset or midnight if
obtained from sunset followed by sunrise
<DD/MM/YY> is date of local noon/midnight fix
<mid value hh:mm> is time of local noon/midnight fix
<mid value secs> is time of local noon/midnight as number of seconds since 1st Jan
1900
<transition 1> is time of sunrise
<transition 2> is time of sunset
<stationery latitude> is latitude calculated assuming a stationery target
<compensated latitude> is latitude compensated for longitudinal movement assuming
uniform movement
<longitude> is longitude
<distance> is distance from last position fix
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<heading> is direction from last fix
<velocity> is calculated velocity from last fix
<confidence> is the confidence level of the fix
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Further discussions on geolocation
As you will see, reliable conversion of light data to position is not always a simple
process. There are a number of things to be understood and considered when
analysing data to produce the most accurate results.
In most of the discussion below I talk about a position based on local noon, calculated
from the sunrise and sunset before and after, respectively. Positions can just as easily
be calculated using local midnight, calculated from the sunset and sunrise before and
after respectively.
The geolocator BAS uses for research only records light (irradiance), saline wet/dry
info and, some versions record water temperature. They do not record the full range of
daylight through the day, only during dawn and dusk when the light level is low (only
a 6-bit range). Also, they do not record pressure. Pressure, and the full range of
daylight help to adjust for light measurements taken in deep water. Therefore, when
BAS geolocators are mounted on animals which go underwater, the more time the
animal spends out of the water, the better the results.
Because the logger saturates at quite a low light level and does not record the full
range of daylight, it is also largely unsuitable for using 'curve fit' (or 'template'), or
‘variable reference’ methods to establish location (though the profile of the curves can
give some clue as to weather conditions and what the bird was doing). These methods
have been found by some to provide better location accuracy than using 'threshold'
methods. But by using the more established and simpler threshold method to convert
sunrise/sunset into location, it means that we can make our loggers much smaller and
last much longer.
After the errors caused by interference (shading, artificial light sources), the cause of
most error is the poor conversion of light level to sunrise/sunset time. The actual
conversion of sunset/sunrise time to position can be done very accurately using
accurate astronomical algorithms (see 'Astronomical Algorithms' by Jean Meeus).
Most of the error is because of the uncontrollable and non-measured weather factors
e.g. cloud, mist, fog, snow. A change in cloud thickness causes a change in light level.
Because the identification of sunset and sunrise time is determined by the light level
crossing a specified threshold level, the crossing time will be affected by cloud. This
can cause a big change in the expected altitude angle for the Sun, which is primary
information for the latitude calculation. If the amount of cloud is different at sunset
from sunrise, then the longitude will have an error, too, as local noon (or local
midnight) will then be shifted. The amount of influence the weather has on the
calculation will depend on time of year and latitude. Attenuation of the light by cloud,
mist or fog will retard sunrises and advance sunsets.
The geolocators are designed to be more sensitive to light around the green/blue part
of the visible spectrum. This is because green/blue light is the portion of the visible
spectrum least attenuated by cloud. This is more suitable for sensing scattered light
from overhead when the Sun is a few degrees below the horizon, corresponding to the
chosen threshold value for data analysis.
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In theory, the effect of cloud could be partially compensated for by examining
satellite weather records. The location fix would have to be first estimated in the
normal way. That location could then be examined on archived satellite images at the
time of sunrise and sunset. The amount of cloud cover shown could be quantised and
a proportional increase/decrease applied to the sun elevation value at the transition
times. The adjusted elevation would give a new time to be used as the compensated
transition time and the position recalculated. Practically it may be difficult to achieve
a substantial increase in accuracy as a satellite image near to every transition time
would need to be examined. Quantising the cloud thickness/cover may be very
difficult.
Another error arising with a logger on a moving bird is due to the fact that the
position of the bird will be different between sunrise and sunset. This can cause an
error with daylength. e.g. a bird flying West will experience a longer day as it moves
with the Sun. This will cause an error in the calculated latitude unless corrected.
BirdTracker goes some way to compensate for this movement. If the bird moves a
different distance before local noon than after, then the longitude will also be affected.
For this reason, some researchers choose to use only local midnight (sunset and
following sunrise) data knowing that the bird they are studying moves far less during
the night than in daylight.
Note that orientation could be considered a form of shading, where it is the logger
shading the sensor from the sun. Shading takes place not only in the immediate
vicinity (e.g. from the body of the bird) but anywhere between the logger and the
assumed horizon (e.g. mountains). Even the rare occurrence of a solar eclipse by the
moon may be recorded! Orientation may or may not be problematic depending on the
amount of movement carried out by the animal. The feature of recording the
maximum light level during each e.g. 10 minutes will reduce any orientation error
with an animal moving in many directions over a 10 minute time span.
Shading due to bird activity has a big effect on results. If the logger is on the leg, a
bird flying during the vital sun transition time will give a better result than one sitting
on the nest during the same time. Indeed, with the logger on the leg of a bird on the
nest, very noisy data may be produced. Note, however, that sometimes other results of
interest can be found from light level. e.g. with a burrowing bird, the amount of time
in the burrow during daylight hours can be found, or e.g. with a bird nesting, the
amount of time on the nest during daylight hours can be estimated.
A little discussed issue regarding loggers mounted on the legs of birds sitting on the
water involves an appreciation of refraction as light travels from air into water. The
resulting reduced viewing window from below the surface probably contributes a
large amount of error into seabird data. Analysing seabird sunset/sunrise data at times
when the logger was dry may give more accurate results than with data when the
logger was wet. The following diagram shows a logger attached to the leg of a bird in
water with the bird removed for clarity:
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The logger’s view of light above is limited to a cone. Depending on the size of the
bird and the depth of the logger in the water, a reduction in light will get to the logger
when the bird is on the water. The circular area on the water surface which comprises
the logger’s viewing window has a radius equal to depth x tan 48.9’ where 48.9’ is the
critical angle for light travelling between air and water mediums.
Because of variable movement of the surface, the bird and the logger due to waves,
sea state and the leg, and varying water clarity, it is difficult to predict how this
quantitatively affects data but it will certainly make it noisier and the positions
determined less accurate. This may account for some of the uncertainty difference
identified by Phillips et al, 2004 between loggers on seabirds and those at static sites.
Position calculations assume that the logger is on the ground. A bird flying at high
altitude will see the sun set and rise at a different time. This will give a longer daylength and cause an error in latitude. Or if, for example, the bird is on the ground at
sunrise but high in the air at sunset, local noon will be shifted and so longitude will be
affected, too.
Stated accuracy of location can be given in miles or in degrees. Latitude always has
about the same distance per degree (60 nautical miles, 69 statute miles or 111km).
Distance per degree of longitude, though, depends on the latitude, and is zero at the
poles and maximum (just under 60 nautical miles) at the equator. Of course, light
geolocation must have a sunset and sunrise, and so the application becomes more
limited closer to the poles where it will not work as there is no daytime or night time
within a 24hr period (it is always light or always dark). Note, though, that longitude
may still be discernable if appreciable twilight or dusk shows in the light data
(although it will be heavily influenced by cloud, mist or fog), as local midnights and
local noons can be calculated.
Because the seasons are less pronounced nearer the equator (i.e. less variation in day
length), the accuracy obtainable close to the equator (or within the 'tropics') is low for
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latitude. For longitude, the accuracy is probably not that different than for high
latitudes. In terms of distance, it may even be better because the twilight and dusk
periods are shorter, meaning that the effect of cloud, mist and fog will be less.
Therefore, for data spanning the whole year, the area of the world where you can
obtain greatest accuracy by geolocation is, for the northern hemisphere, between the
Tropic of Cancer and the Arctic Circle and, for the southern hemisphere, between the
Tropic of Capricorn and the Antarctic Circle.
Sometimes, users tell us that they want a higher sampling rate of light because they
want to see nice sunrise and sunset curves and believe that increasing the accuracy of
the sample time will increase the position accuracy. This is simply not so. The errors
caused by all the other unknown factors such as shading, orientation, weather, and
movement result in larger timing errors than is due to the sampling rate. For any given
sunrise or sunset, without satellite information, there is no way of knowing whether
there was any cloud or not; a nice transition curve will be produced just as clearly
with no cloud as with constant thick cloud or constant mist etc but may be
considerably offset in time.
To produce the most reliable results, as a beginning step, any sunset or sunrise
showing interference by shading should be rejected. For animals spending a lot of
time underwater, perhaps try to use only those sunsets and rises recorded out of water
(shown by the wet/dry record) to minimise errors due to attenuation and refraction of
light by the water.
For loggers spending much time in seawater, bio fouling may be a problem. This will
result in a gradual diminution of light with time. As time goes by, this means that
sunrises will be gradually retarded and sunsets advanced. A calibration period at the
end of deployment will result in a different threshold Sun elevation angle. Assuming
linear degradation over time, results could be processed using a dynamic threshold
level starting with the initial calibrated value and ending with the final calibrated
value. Usually, bio fouling is not an issue due to the movement of the animal in the
water naturally washing the geolocator.
With loggers on land birds, a build of dirt on the light sensor may cause interference
and could build up or wash off periodically or stochastically during deployment. This
has been of particular problem with leg mounted loggers on birds of prey. Because of
this experience, this method of mounting is now strongly not recommended for
raptors.
As can be seen, for the highest accuracy of results a sound understanding of the theory
should be attained and also, if possible, information about the habit of the animal you
are studying. Other data such as satellite weather images and remote sea surface
temperature can help in improving accuracy. Data should not be blindly fed through a
light level to position calculation routine (unless it takes absolutely everything into
account!). Hopefully, this section has provided a brief overview of many of the
nuances of light geolocation. For further details and example studies, please see the
publications listed at our website at www.birdtracker.co.uk.
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